GMPLS UNI for Packet and Optical Integration

With cloud becoming increasingly central to business operations, packet and optical network services must evolve to become more efficient and dynamic. Closer integration of packet and optical networks becomes critical especially in the control plane.

- Use Case Overview, on page 2
- Prerequisites, on page 2
- Limitations, on page 3
- Configuration Workflow, on page 3
- Verification, on page 9
- General Troubleshooting, on page 16
- You May Be Also Interested In, on page 16

Generalized Multiprotocol Label Switching (GMPLS) User Network Interface (UNI) or GMPLS UNI is a key technology enabling this integration. GMPLS UNI enables the packet networks to directly tap into the optical transport control plane to coordinate its resource requirements with the optical transport network. Leveraging open standards, GMPLS UNI optimizes network resources and improves network utilization across packet and optical networks.

**Channel Spacing**

DWDM grid (C-band: 1530-1569 nm) in the optical spectrum can be divided into multiple channels so that each channel can carry traffic independently. The number of channels that we receive from the DWDM grid depends on the channel spacing. For example, lower the channel spacing, higher the number of channels and vice versa.

GMPLS has two types of channel spacing.

- Fixed Grid channel spacing - The channel spacing is fixed to 50 GHz and supports 100 and 200 Gbps traffic.

- Flexible Grid channel spacing - The channel spacing is 6.25 GHz and supports all the data rates. The channels are divided in finer slices so that the channel width is defined as multiples of these fine slices that fit data bandwidth requirement.

  NCS 1004 supports only flexible grid channel spacing.

  The **neighbor flexi-grid-capable** command enables GMPLS UNI flexible grid channel spacing. This command is executed during the Configure LMP on Cisco NCS 1004 Node configuration.
Use Case Overview

GMPLS UNI technology addresses the following customer needs in packet and optical networks.

- Effective usage of DWDM grid with minimal wastage of spectral bandwidth.
- Transmission of mixed bit-rate or mixed modulation data in a grid with different channel widths.

To address these needs, you create a tunnel between two NCS 1004 nodes to carry traffic using GMPLS UNI technology as shown in the following figure.

**Figure 1: GMPLS UNI Reference Model**

UNI-C is the client or packet or router node, for example, NCS 1004 nodes. UNI-N is the network or optical node, for example, NCS 2000 nodes.

Link Management Protocol (LMP) link is created to establish connectivity between a NCS 2000 node and a NCS 1004 node. The tunnel is then created between the trunk interfaces of the source and destination NCS 1004 nodes to carry traffic. When the tunnel is created between NCS 1004 nodes, a circuit is internally created between the NCS 2000 nodes. The circuit is created to perform path computation, restoration, and reversion functions.

The tunnel can be created between the source and destination NCS 1004 nodes without involving NCS 2000 nodes in the middle. However, the restoration and reversion capabilities are provided only by NCS 2000 nodes using GMPLS UNI.

Perform the following tasks in sequence to create a tunnel using GMPLS UNI.

**Configurations on the NCS 2000 node:**
1. Configure LMP and Alien Wavelength on NCS 2000 Node Using CTC, on page 3
2. Retrieve Ifindex from NCS 2000 Node, on page 5

**Configurations on the NCS 1004 node:**
1. Configure LMP on Cisco NCS 1004 Node, on page 6
2. Configure RSVP on NCS 1004 Node, on page 8
3. Configure MPLS Tunnel on NCS 1004 Node, on page 8

Prerequisites

Before you create a tunnel using GMPLS UNI, ensure to meet these prerequisites.
• NCS 1004 node must have both the MPLS and MPLS-TE packages. The package names are ncs1004-mpls and ncs1004-mpls-te-rsvp.
• NCS 2000 node must have a valid license for ROADM and WSON support.
• The management IP addresses of NCS 1004 and NCS 2000 nodes must be accessible.
• The administrative state of the trunk port of the optics controller on the NCS 1004 node must not be in the shutdown state.

Limitations

Configuration Workflow

Perform the following tasks in sequence to create a tunnel using GMPLS UNI.

Configurations on the NCS 2000 node:
1. Configure LMP and Alien Wavelength on NCS 2000 Node Using CTC, on page 3
2. Retrieve Ifindex from NCS 2000 Node, on page 5

Configurations on the NCS 1004 node:
1. Configure LMP on Cisco NCS 1004 Node, on page 6
2. Configure RSVP on NCS 1004 Node, on page 8
3. Configure MPLS Tunnel on NCS 1004 Node, on page 8

Configure LMP and Alien Wavelength on NCS 2000 Node Using CTC

This procedure creates a static LMP link to establish connectivity between a NCS 2000 node and a NCS 1004 node. The LMP creation wizard in CTC provides the capability to select source and destination end points of the LMP link, optical parameters, and alien wavelength settings.

Step 1  From the View menu, choose Go to Network View.
Step 2  Click the Provisioning > LMP tabs.
Step 3  Click Create.

The LMP Creation window appears.

Step 4  Click Signaled in the Router Not Managed by CTC area.
Step 5  A wizard appears with the following options.

LMP Origination, LMP Termination, Optical Parameters, and Alien Wavelength

Step 6  In the LMP Origination screen of the wizard, provision these parameters.
• From the Originating Node drop-down list, choose the source node of the LMP.
If the source node is Cisco NCS 1004, the destination node must be MSTP and vice versa.

- From the Local Interfaces drop-down list, choose an available interface.
- Choose the Type, Shelf, Slot, and Port for Ingress Port Selection and Egress Port Selection.
- Choose **Numbered** interface.
- Enter the IP address of the source node in the Interface IP field.
- **Mode**—Sets the type of revertive restoration to either UNI-C or UNI-N. If the mode is set to UNI-C, the reversion of the circuit from the restored path to the original path is triggered by the UNI client that is connected to Cisco NCS 1004. If the mode is set to UNI-N, the reversion of the circuit is triggered by the DWDM network and can either be a manual revert or an auto revert.
- Enter the RSVP signaling interval and RSVP signaling missed values in the respective fields.
- Click **Next**.

**Step 7**

In the LMP Termination screen of the wizard, provision these parameters.

- From the Terminating Node drop-down list, choose the destination node of the LMP, for example, MSTP node.
- **Rx Port Selection**—Choose the card type from the Type drop-down list; choose a shelf from the Shelf drop-down list; choose a source slot from Slot drop-down list; choose a port from the Port drop-down list.
- **Tx Port Selection**—Choose the card type from the Type drop-down list; choose a shelf from the Shelf drop-down list; choose a destination slot from Slot drop-down list; choose a port from the Port drop-down list.
- Enter the IP address of the destination node in the Interface IP field.
- **Mode**—Sets the type of revertive restoration to either UNI-C or UNI-N. If the mode is set to UNI-C, the reversion of the circuit from the restored path to the original path is triggered by the UNI client that is connected. If the mode is set to UNI-N, the reversion of the circuit is triggered by the DWDM network and can be either a manual revert or an auto revert.
- Enter the remote Ifindex of NCS 1004 node (in decimals) in the Remote If Index field.
- Click **Next**.

**Step 8**

In the Optical Parameters screen of the wizard, provision these parameters.

- **Allow Regeneration**—When checked, the computed path traverses through the regeneration site only if the optical validation is not satisfied. The user can regenerate a circuit that is created from UNI interface. If a transparent path is feasible, the regenerator is not used.
- **UNI State**—Choose **Enable** or **Disable** from the UNI State drop-down list.
  
  The Enable state is used to configure the UNI interface for the circuits to pass through, between the router and DWDM node. In the Disable state, the interface is configured but not active and circuit activation is rejected. When the status is changed from Enable to Disable, all the active circuits on the interface are deleted.
- **Description**—Enter the description of the UNI interface. The description can be up to 256 characters.
- **Label**—Enter an alphanumeric string. This label is a unique circuit identifier.
- **Validation**—Sets the optical validation mode.
• Full—The circuit gets created when the circuit validation result is greater than or equal to the acceptance threshold value.

• None—The circuit is created without considering the acceptance threshold value. The Opt Valid column in the Circuits tab displays the value, “No Valid”.

• Inherited—The restoration circuit inherits the validation and acceptance threshold values from the primary circuit.

• Acceptance threshold—Sets the acceptance threshold value for the GMPLS circuit. The circuit is created if the actual acceptance threshold value is greater than, or equal to, the value set in this field.
  • Green—Indicates that the channel failure risk is 0%.
  • Yellow—Indicates that the channel failure risk is between 0% and 16%.
  • Orange—Indicates that the channel failure risk is between 16% and 50%.
  • Red—Indicates that the channel failure risk is greater that 50%.

• Restoration—Check this check box to enable the restoration of the GMPLS circuits on the UNI interface.

• Revert—Check this check box to enable the revert of the GMPLS circuits on the UNI interface.

• Auto Revert—Click this radio button to automatically revert the circuit from the restored path to the original path after the failure is fixed, WSON alarms are acknowledged, and the soak time expires.

• Manual Revert—Click this radio button to manually revert the circuit from the restored path to the original path after the failure is fixed, the WSON alarms are acknowledged, and the soak time expires.

• Soak Time—Enter the time (in hours, minutes, and seconds) in the Soak Time field that the circuit on the restored path waits before moving to the original path after the failure is fixed. The circuit reverts to the original path after the soak time expires. The soak time must be set only if both the Restoration and Revert check boxes are checked.

  • Click Next.

**Step 9** In the Alien wavelength screen of the wizard, provision these parameters.

  • From the Alien Wavelength drop-down list, choose the alien wavelength class.

  • From the Trunk Selection drop-down list, choose 100G, 200G, or 250G.

  • From the FEC drop-down list, choose a valid value for forward error correction (FEC) mode. If an invalid FEC value is chosen, LMP link is created; however, circuit creation fails.

  • Click Finish to create an LMP link.

  The newly created LMP link appears in the LMP table in CTC.

---

**Retrieve Ifindex from NCS 2000 Node**

The Ifindex value of all the LMP ports of NCS 2000 node can be retrieved using CTC or TL1.

**Using CTC:**
From the **Provisioning > LMP** tab, retrieve the Ifindex value in decimal format under the **Originating Interface Index** column.

This Ifindex value is used in the **neighbor interface-id unnumbered** command during the **Configure LMP on Cisco NCS 1004 Node** configuration.

**Using TL1:**
1. Log in to the TL1 interface and issue the following command.
   ```
   rtrv-unicfg ::all:1;
   ```

This command retrieves the Ifindex of all the LMP ports of NCS 2000 node in hexadecimal format. This must be converted to decimal format and used in remote Ifindex of NCS 1004 node during the **Configure LMP on Cisco NCS 1004 Node** configuration.

**TL1 Output**

```
PSLINE-81-1-9-RX:PSLINE-81-1-9-TX,10.77.142.92,3.3.3.4,3.3.3.3,0.0.0.0,VALMODE=NONE,ADMINSTATE=UP,
RESTTYPE=REVERT,USPWROFS=0.0,
DSPWROFS=0.0,ALLOWREGEN=NO,UNICTRLMODE=CLIENT,REVERTMODE=MANUAL,SOAK=00-01-00,
RESTVALMODE=NONE,TERMINTFDX=0,ORIGINTFIDX=7f000d12,NUMBERED=TRUE,UNIMODE=GMPLS
PSLINE-81-1-10-RX:PSLINE-81-1-10-TX,10.77.142.92,4.4.4.4,4.4.4.3,0.0.0.0,VALMODE=NONE,ADMINSTATE=UP,
RESTTYPE=REVERT,USPWROFS=0.0,DSPWROFS=0.0,ALLOWREGEN=NO,UNICTRLMODE=CLIENT,
REVERTMODE=MANUAL,SOAK=00-01-00,RESTVALMODE=NONE,TERMINTFDX=0,
ORIGINTFIDX=7f000d14,NUMBERED=TRUE,UNIMODE=GMPLS
```

The Ifindex of Port 81-1-9 is 7f000d12 (in hexadecimal) and 2130709778 (in decimal). The Ifindex of Port 81-1-10 is 7f000d14 (in hexadecimal) and 2130709780 (in decimal).

**Configure LMP on Cisco NCS 1004 Node**

LMP is a logical link that must be created on the trunk optics controller of the source and destination NCS 1004 nodes of the tunnel.

```
configure
lmp
gmpls optical-uni
ccontroller optics  Rack/Slot/Instance/Port
neighbor  name
neighbor link-id ipv4 unicast  ipv4-address
neighbor flexi-grid-capable
neighbor interface-id unnumbered  interface-id
link-id ipv4 unicast  ipv4-address
ipcc routed
router-id ipv4 unicast  ipv4-address
commit
```
Important Notes

- **neighbor link-id ipv4 unicast** *ipv4-address* is the IP address of the MSTP interface on the NCS 2000 node.

- **neighbor flexi-grid-capable** enables GMPLS UNI flexible grid channel spacing.

- **neighbor interface-id unnumbered** *interface-id* is the optical interface ID of the neighbor. This value is the Ifindex value of all the LMP ports of NCS 2000 node in decimal format that is manually retrieved from CTC or TL1. See Retrieve Ifindex from NCS 2000 Node, on page 5 to retrieve the Ifindex.

- **link-id ipv4 unicast** *ipv4-address* is the IP address of the optics controller on the current NCS 1004 node.

- **router-id ipv4 unicast** *ipv4-address* is the neighbor router IP address for GMPLS UNI.

Running Configuration

The following is a sample of configuring LMP on the source NCS 1004 node.

```plaintext
show running-config lmp

Mon Jul  1 14:42:46.856 IST
lmp
  gmples optical-uni
  controller Optics0/0/0/0
    neighbor ncs1k
    neighbor link-id ipv4 unicast 10.1.1.1
    neighbor flexi-grid-capable
    neighbor interface-id unnumbered 2130706976
    link-id ipv4 unicast 11.1.1.1
  !
  controller Optics0/0/0/1
    neighbor ncs1k
    neighbor link-id ipv4 unicast 10.3.3.3
    neighbor flexi-grid-capable
    neighbor interface-id unnumbered 2130707232
    link-id ipv4 unicast 11.3.3.3
  !
  controller Optics0/1/0/0
    neighbor ncs1k
    neighbor link-id ipv4 unicast 10.4.4.4
    neighbor flexi-grid-capable
    neighbor interface-id unnumbered 2130706964
    link-id ipv4 unicast 11.4.4.4
  !
  controller Optics0/1/0/1
    neighbor ncs1k
    neighbor link-id ipv4 unicast 10.5.5.5
    neighbor flexi-grid-capable
    neighbor interface-id unnumbered 2130706966
    link-id ipv4 unicast 11.5.5.5
  !
  neighbor ncs1k
  ipcc routed
  router-id ipv4 unicast 10.127.60.48
  !
  router-id ipv4 unicast 10.105.57.101
  !
```

GMPLS UNI for Packet and Optical Integration
Configure RSVP on NCS 1004 Node

Resource Reservation Protocol (RSVP) with appropriate timeout must be configured on the source and destination NCS 1004 nodes of the tunnel.

```
configure
rsvp
controller optics Rack/Slot/Instance/Port
signalling refresh out-of-band interval interval
signalling refresh out-of-band missed mis-count
commit
```

The following is a sample of configuring RSVP on the source NCS 1004 node.

```
RP/0/RP0/CPU0:ios#configure
RP/0/RP0/CPU0:ios(config)#rsvp
RP/0/RP0/CPU0:ios(config-rsvp)#controller optics 0/0/0/6
RP/0/RP0/CPU0:ios(config-rsvp-cntl)#signalling refresh out-of-band interval 3600
RP/0/RP0/CPU0:ios(config-rsvp-cntl)#signalling refresh out-of-band missed 24
RP/0/RP0/CPU0:ios(config-rsvp-cntl)#commit
```

Configure MPLS Tunnel on NCS 1004 Node

Ensure that the administrative state of the trunk port of the optics controller on the NCS 1004 node is not in shutdown state.

```
configure
mpls traffic-eng
gmpls optical-uni
controller optics Rack/Slot/Instance/Port
tunnel-properties
tunnel-id id
destination ipv4 unicast ipv4-address
path-option 10 no-ero lockdown
commit
```

Important Notes

- **destination ipv4 unicast ipv4-address** is the IP address of the optics controller on the destination NCS 1004 node.
- Explicit Route Object (ERO) - Includes the route(s) to be used through a list of specified nodes for a tunnel.
- Exclude Route Object (XRO) - Excludes the route(s) to be used through a list of specified nodes for a tunnel.
Running Configuration

The following is a sample of configuring the MPLS tunnel on the source NCS 1004 node.

```
RP/0/RP0/CPU0:ios#configure
RP/0/RP0/CPU0:ios(config)#mpls traffic-eng
RP/0/RP0/CPU0:ios(config-mpls-te)#gmpls optical-uni
RP/0/RP0/CPU0:ios(config-te-gmpls-uni)#controller optics 0/0/0/6
RP/0/RP0/CPU0:ios(config-te-gmpls-cntl)#tunnel-properties
RP/0/RP0/CPU0:ios(config-te-gmpls-tun)#tunnel-id 100
RP/0/RP0/CPU0:ios(config-te-gmpls-tun)#destination ipv4 unicast 100.20.20.20
RP/0/RP0/CPU0:ios(config-te-gmpls-tun)#path-option 10 no-ero lockdown
RP/0/RP0/CPU0:ios(config-te-gmpls-tun)#commit
```

The following is a sample of configuring the MPLS tunnel on the destination NCS 1004 node.

```
RP/0/RP0/CPU0:ios#configure
RP/0/RP0/CPU0:ios(config)#mpls traffic-eng
RP/0/RP0/CPU0:ios(config-mpls-te)#gmpls optical-uni
RP/0/RP0/CPU0:ios(config-te-gmpls-uni)#controller optics 0/0/0/6
RP/0/RP0/CPU0:ios(config-te-gmpls-uni)#commit
```

Verification

Use the show commands in the following table to verify the GMPLS UNI tunnel, RSVP, and LMP configuration.

**Table 1: Show Commands**

<table>
<thead>
<tr>
<th>Show Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>show mpls traffic-eng link-management optical-uni controller optics</td>
<td>Displays detailed GMPLS information of specific optics controller.</td>
</tr>
<tr>
<td>show mpls traffic-eng link-management optical-uni</td>
<td>Displays detailed GMPLS information of all the optics controllers.</td>
</tr>
<tr>
<td>show mpls traffic-eng tunnels</td>
<td>Displays information about tunnels.</td>
</tr>
<tr>
<td>show mpls traffic-eng link-management optical-uni tabular</td>
<td>Displays detailed GMPLS information of all the optics controllers in tabular format.</td>
</tr>
<tr>
<td>show mpls traffic-eng tunnels tabular</td>
<td>Displays information about all the tunnels in tabular format.</td>
</tr>
<tr>
<td>show lmp gmpls optical-uni</td>
<td>Verifies LMP configuration and state.</td>
</tr>
<tr>
<td>show rsvp neighbors</td>
<td>Displays information about RSVP neighbors.</td>
</tr>
</tbody>
</table>

**Sample Outputs**

***show mpls traffic-eng link-management optical-uni controller optics 0/0/0/13***

```
Mon Jul 1 20:05:27.209 IST
```

Displays detailed GMPLS information of specific optics controller.
Optical interface: Optics0/0/0/0

Overview:
  - IM state: Up
  - Child interface: IM state Unknown
  - OLM/LMP state: Up
  - Optical tunnel state: up

Connection:
  - Tunnel role: Tail
  - Tunnel-id: 15, LSP-id 3, Extended tunnel-id 10.105.57.100
  - Tunnel source: 10.105.57.100, destination: 11.1.1.1
  - Optical router-ids: Local: 10.105.57.101, Remote: 10.127.60.48
  - Label source: UNI-N

Upstream label:
  - Optical label:
  - Grid: DWDM
  - Channel spacing: 6.25 GHz
  - Identifier: 0
  - Channel Number: -277

Downstream label:
  - Optical label:
  - Grid: DWDM
  - Channel spacing: 6.25 GHz
  - Identifier: 0
  - Channel Number: -277

SRLG discovery: Disabled
SRLG announcement: None

Switching Type: lsc
MTU: 9212

Admission Control:
  - Upstream: Admitted (LSP ID: 3)
  - Downstream: Admitted (LSP ID: 3)

OLM/LMP adjacency information:
  - Adjacency status: Up
    - Local:
      - node ID: 10.105.57.101
      - link interface ID: 10
      - link ID: 11.1.1.1
    - Neighbor:
      - node ID: 10.127.60.48 (VEGA2K-Site-3_48)
      - link interface ID: 2130706976
      - link ID: 10.1.1.1
      - IPCC: Routed to 10.127.60.48

Optical capabilities:
  - Controller type: DWDM
  - Channel spacing: 6.25 GHz
  - Default channel: 0
  - 784 supported channels:
    - -303, -302, -301, -300, -299, -298, -297, -296
    - -295, -294, -293, -292, -291, -290, -289, -288
    - -287, -286, -285, -284, -283, -282, -281, -280
    - -279, -278, -277, -276, -275, -274, -273, -272
    - -271, -270, -269, -268, -267, -266, -265, -264
    - -263, -262, -261, -260, -259, -258, -257, -256
    - -255, -254, -253, -252, -251, -250, -249, -248
    - -247, -246, -245, -244, -243, -242, -241, -240
    - -239, -238, -237, -236, -235, -234, -233, -232
    - -231, -230, -229, -228, -227, -226, -225, -224
    - -223, -222, -221, -220, -219, -218, -217, -216
    - -215, -214, -213, -212, -211, -210, -209, -208
    - -207, -206, -205, -204, -203, -202, -201, -200
    - -199, -198, -197, -196, -195, -194, -193, -192
    - -191, -190, -189, -188, -187, -186, -185, -184
    - -183, -182, -181, -180, -179, -178, -177, -176
    - -175, -174, -173, -172, -171, -170, -169, -168
Controller SRLGs
None

show mpls traffic-eng link-management optical-uni

Displays detailed GMPLS information of all the optics controllers. MPLS tunnels are not created when the optics controller is in the shutdown state. The state is shown as "Admin down". Issue the no shutdown command under the optics controller to initiate the tunnel creation.

Mon Jul 1 20:00:42.108 IST

System Information:
  Optical Links Count: 1 (Maximum Links Supported 100)

  Optical interface: Optics0/0/0/0
  Overview:
    IM state: Up
    Child interface: : IM state Unknown
    OLM/LMP state: Up
    Optical tunnel state: up
  Connection:
    Tunnel role: Tail
    Tunnel-id: 15, LSP-id 3, Extended tunnel-id 10.105.57.100
    Tunnel source: 10.105.57.100, destination: 11.1.1.1
    Optical router-ids: Local: 10.105.57.101, Remote: 10.127.60.48
    Label source: UNI-N
  Upstream label:
    Optical label:
      Grid : DWDM
      Channel spacing : 6.25 GHz
      Identifier : 0
      Channel Number : -277
  Downstream label:
    Optical label:
      Grid : DWDM
      Channel spacing : 6.25 GHz
      Identifier : 0
      Channel Number : -277
    SRLG discovery: Disabled
    SRLG announcement: None
  Switching Type: lsc
  MTU: 9212
  Admission Control:
    Upstream: Admitted (LSP ID: 3)
    Downstream: Admitted (LSP ID: 3)
  OLM/LMP adjacency information:
Adjacency status: Up

Local:
  node ID: 10.105.57.101
  link interface ID: 10
  link ID: 11.1.1.1

Neighbor:
  node ID: 10.127.60.48 (VEGA2K-Site-3_48)
  link interface ID: 2130706976
  link ID: 10.1.1.1
  IPCC: Routed to 10.127.60.48

Optical capabilities:
  Controller type: DWDM
  Channel spacing: 6.25 GHz
  Default channel: 0
  784 supported channels:
  -303, -302, -301, -300, -299, -298, -297, -296
  -295, -294, -293, -292, -291, -290, -289, -288
  -287, -286, -285, -284, -283, -282, -281, -280
  -279, -278, -277, -276, -275, -274, -273, -272
  -271, -270, -269, -268, -267, -266, -265, -264
  -263, -262, -261, -260, -259, -258, -257, -256
  -255, -254, -253, -252, -251, -250, -249, -248
  -247, -246, -245, -244, -243, -242, -241, -240
  -239, -238, -237, -236, -235, -234, -233, -232
  -231, -230, -229, -228, -227, -226, -225, -224
  -223, -222, -221, -220, -219, -218, -217, -216
  -215, -214, -213, -212, -211, -210, -209, -208
  -207, -206, -205, -204, -203, -202, -201, -200
  -199, -198, -197, -196, -195, -194, -193, -192
  -191, -190, -189, -188, -187, -186, -185, -184
  -183, -182, -181, -180, -179, -178, -177, -176
  -175, -174, -173, -172, -171, -170, -169, -168
  -167, -166, -165, -164, -163, -162, -161, -160
  -159, -158, -157, -156, -155, -154, -153, -152
  -151, -150, -149, -148, -147, -146, -145, -144
  -143, -142, -141, -140, -139, -138, -137, -136
  -135, -134, -133, -132, -131, -130, -129, -128
  -127, -126, -125, -124, -123, -122, -121, -120
  -111, -110, -109, -108, -107, -106, -105, -104
  -103, -102, -101, -100, -99, -98, -97, -96
  -95, -94, -93, -92, -91, -90, -89, -88
  -87, -86, -85, -84, -83, -82, -81, -80
  -79, -78, -77, -76, -75, -74, -73, -72
  -71, -70, -69, -68, -67, -66, -65, -64
  -63, -62, -61, -60, -59, -58, -57, -56
  -55, -54, -53, -52, -51, -50, -49, -48
  -47, -46, -45, -44, -43, -42, -41, -40
  -39, -38, -37, -36, -35, -34, -33, -32
  -31, -30, -29, -28, -27, -26, -25, -24
  -23, -22, -21, -20, -19, -18, -17, -16
  -15, -14, -13, -12, -11, -10, -9, -8
  -7, -6, -5, -4, -3, -2, -1, 0
1, 2, 3, 4, 5, 6, 7, 8
9, 10, 11, 12, 13, 14, 15, 16
17, 18, 19, 20, 21, 22, 23, 24
25, 26, 27, 28, 29, 30, 31, 32
33, 34, 35, 36, 37, 38, 39, 40
41, 42, 43, 44, 45, 46, 47, 48
49, 50, 51, 52, 53, 54, 55, 56
57, 58, 59, 60, 61, 62, 63, 64
65, 66, 67, 68, 69, 70, 71, 72
73, 74, 75, 76, 77, 78, 79, 80
81, 82, 83, 84, 85, 86, 87, 88
Controller SRLGs
None

show mpls traffic-eng link-management optical-uni tabular
Displays detailed GMPLS information of all the optics controllers in tabular format.

Mon Jul 1 15:10:50.472 IST

System Information:
Optical Links Count: 4 (Maximum Links Supported 100)

<table>
<thead>
<tr>
<th>Interface</th>
<th>Admin</th>
<th>Oper</th>
<th>Adjacency</th>
<th>LMP</th>
<th>GMPLS tunnel</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td></td>
<td></td>
<td>role</td>
<td>tun-id</td>
<td>state</td>
</tr>
</tbody>
</table>

GMPLS UNI for Packet and Optical Integration
show mpls traffic-eng tunnels
Displays information about tunnels.

Mon Jul 1 15:03:58.490 IST

LSP Tunnel 10.105.57.100 15 [5] is signalled, Signaling State: up
Tunnel Name: ckt0/0/0/0 Tunnel Role: Tail
Upstream label:
  Optical label:
    Grid : DWDM
    Channel spacing : 6.25 GHz
    Identifier : 0
    Channel Number : -277
Downstream label:
  Optical label:
    Grid : DWDM
    Channel spacing : 6.25 GHz
    Identifier : 0
    Channel Number : -277
Signalling Info:
  Src 10.105.57.100 Dst 11.1.1.1, Tun ID 15, Tun Inst 5, Ext ID 10.105.57.100
  Router-IDs: upstream 10.127.60.48
  local 10.105.57.101
  Priority: 7 7
  SRLGs: not collected
Path Info:
  Incoming Address: 10.1.1.1
  Incoming:
    Explicit Route:
      No ERO
  Route Exclusions:
    No XRO
    Record Route: Disabled
  Tsputc: avg rate=4294967033 kbits, burst=1000 bytes, peak rate=4294967033 kbits
  Session Attributes: Local Prot: Not Set, Node Prot: Not Set, BW Prot: Not Set
  Resv Info: None
  Record Route: Disabled
  Fspec: avg rate=4294967033 kbits, burst=1000 bytes, peak rate=4294967033 kbits
Displayed 0 (of 0) heads, 0 (of 0) midpoints, 1 (of 1) tails
Displayed 0 up, 0 down, 0 recovering, 0 recovered heads

show rsvp neighbors
Displays information about RSVP neighbors.

Mon Jul 1 14:58:48.888 IST
Global Neighbor: 10.127.60.48
  Interface Neighbor Interface
  --------------------------- --------
  10.127.60.48 MgmtEth0/RP0/CPU0/0

show lmp gmpls optical-uni
Verifies LMP configuration and state.
General Troubleshooting

It is recommended to collect and analyze the output of the following commands for any software issues.

- `show tech-support mpls traffic-eng file filename`
- `show tech-support mpls rsvp file filename`
- `show lmp clients`
- `show rsvp neighbors`
- `show mpls traffic-eng link-management optical-uni controller optics Rack/Slot/Instance/Port`
- `show mpls traffic-eng tunnels tunnel-id`

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>When NCS 2000 node cannot route the DWDM wavelength to the destination, it displays a generic error message as &quot;No Route to destination&quot;.</td>
<td>As a super user, collect and analyze the diagnostic information by entering the following address in the browser. <a href="http://ip-address-of-head-node/diagnostics/wson">http://ip-address-of-head-node/diagnostics/wson</a></td>
</tr>
</tbody>
</table>

You May Be Also Interested In

- GMPLS UNI commands: [Cisco IOS XR MPLS Command Reference](#)
- GMPLS Restoration and Reversion